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SUMMARY 

 

 
This particular system is a programmable gas sample system based on the PGS32 range 

of equipment and is used for the monitoring gaslevels within air samples taken from remote 

points. 

This manual includes a system description, operation and maintenance details.  It is 

intended to compliment the equipment and is therefore tailored to the specifications and 

operation procedure of the system supplied. 

 

 

 

 

 

 

 

 

 

WARNING 
 

 

The equipment described in this instruction manual may have mains 

voltages applied to it.  Ensure correct safety procedures are adopted 

before working on the equipment. 

 

The equipment described in this handbook is designed for detection 

of flammable and/or toxic gases. Ensure local safety procedures are 

adopted before carrying out any maintenance or calibration work. 

 

The equipment described in this handbook may be connected to 

remote alarms and/or shutdown systems.  Ensure that local operating 

procedures are adopted before carrying out any maintenance or 

calibration work. 
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1. OVERVIEW 
 

The supplied system is a Programmable Sample System to monitor levels of gas present in 

air samples taken from remote points. Samples are drawn from up to thirty-two 10mm 

sample tubes which are sequentially monitored. The air samples are conditioned by filters 

before passing over gas detectors. The gas levels are monitored by the GasScan program, 

which will operate output relays if any gases exceed pre-defined levels. A modem can be 

fitted to provide dial-out facilities using PC Anywhere software. 

The system is supplied fully configured as per the drawings and specification sheets. If any 

parameters need changing to suit site conditions (i.e. sample/purge times, alarm levels etc.) 

please consult the Crowcon Commissioning Engineer. Alternatively, all information needed 

to implement any changes are included in this manual. 

 

2. INTRODUCTION 
 

The Programmable Sampling System supplied on this project is a microprocessor-

controlled system for monitoring gas concentrations from up to 32 remote points by means 

of sample draw techniques.  The system utilises a rack mounted IBM compatible PC which 

controls all sampling and alarming functions including pump operation, sampling sequence, 

and alarm relay drives. 

 

The system is supplied complete with all necessary sample-conditioning components, such 

as particulate filters and water barriers, to ensure a consistently clean and dry sample at 

the detectors.  

 

All the controlling and data logging software has been written by Crowcon and utilises 

Microsoft Windows™ 98 to allow quick and easy modification to the system parameters 

and to manually override the system functions. 

 

3.  SYSTEM DESCRIPTION 
 

3.1  ENCLOSURE 
 

The system is housed in a sheet steel enclosure designed for wall mounting and measures 

1000mm high x 800 mm wide x 400 mm deep. 

 

The enclosure houses the PC complete with flat screen LCD display and keyboard, the 

system power supply, output relays and a top entry gland panel for connection of all 

incoming and outgoing electrical signals.  All terminals will accept up to 2.5-mm2 cable. 

 

The enclosure also houses the mechanical sampling system complete with detectors, left 

hand entry bulkhead fittings for incoming sample lines, air purge inlet, calibrate inlet, and 

drain connections. The exhaust connections are made on the right hand side of the 

cabinet. All inlet and exhaust connections are 10-mm o/d, except the Calibration inlet and 

Drain, which are 6mm o/d. 

 

A cooling/extract fan ensures that the internal operating temperature remains stable and 

prevents the unit overheating.  For systems detecting flammable gases, an internal cabinet 

gas detector is also provided which will shut down the system pumps in the event of gas 

being detected within the cabinet. 
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 3.2 HARDWARE 
 

The system is capable of accepting up to 32 sample lines, each of which can be up to 1 km 

in length.  The sample pipe material used should be suitable for the application and, where 

necessary, laid in conduit for physical protection. 

 

Using the internal pump and sample conditioning components, each sample is presented to 

the gas detectors.  The configuration of sample line sequence and the sampling times for 

each inlet are set in software during commissioning and stored on the PC.  Up to 99 

different configurations can be selected. A vacuum transducer monitors for flow fail 

conditions i.e. a blocked sample line. 

 

The sample system contains up to four eight-way valve blocks, each valve is connected to 

a 10 mm sample inlet bulkhead compression fitting. The sample outlet from the valve 

blocks is fed through particulate and condensate filters with an automatic drain, through the 

pump and then a flow regulator.  From the flowmeter it passes across the detectors and out 

to exhaust. A backing pump is also fitted which is used to present fresh samples at the 

manifold ready for sampling by the main system. 

 

Field terminals are provided for connection of a mains supply, and system outputs.  

Optionally, up to 4 I/O modules can be fitted, each of which can either be a Relay Module 

or an Analogue Module.  The Relay Modules are fitted with 4 DPCO 5 A and 4 SPCO 10 A 

relays.  The Analogue Modules include 8 inputs and 2 outputs, all of which are 4-20 mA 

rated at 800  maximum load at 24 V dc. 

 

 

3.3 PC SYSTEM 
 

An industrial PC complete with keyboard / mousepad, colour LCD display, 3.5” disk drive 

and CD-ROM is mounted on the front of the enclosure. 

 

The PC itself is an AMD 500 and is supplied with Windows™ 98 operating systems. The 

PC system includes an interface control module for communicating with the detectors and 

other analogue devices, such as pressure transducers. 

 

 

3.4 SOFTWARE 
 

Software supplied with the system includes the Crowcon GasScan System, and Symantec  

PC Anywhere on those systems where a modem is fitted, this system software controls the 

operational characteristics of the system, signals alarms, creates databases and can 

communicate with remote PCs. 

 

When configuring the system, the software allows the user to set the sampling sequence, 

sampling times and the scanning period. It also allows scheduling for automatic transfer of 

data to a remote PC. 

 

The system accepts up to 11 analogue inputs via the control module (additional analogue 

inputs can be connected via analogue modules).  As standard these would comprise the 

detector, the vacuum transducer (line blockage), and internal gas detector.  The remaining 

inputs can be used for a combination of parameters such as atmospheric pressure or 

ambient temperature. 
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Data received from these transducers can be displayed in tabular, graphic or mimic format, 

the mimic can be produced by the user using Paintbrush or by Crowcon at an additional 

cost.  In addition historical data is stored on the internal PC hard drive for up to 1 million 

data points.  Each data point comprises readings from each of the analogue inputs plus a 

time and date stamp.  Using the optional package of the modem and the PC Anywhere 

software, this data can be accessed from a remote PC either on demand or be 

programmed to automatically download at regular intervals.  System alarms can also be 

logged and transmitted to the remote PC. 

 

All logged data is available for transfer to almost all current spreadsheet packages using 

the .CSV (comma separated variable) file format, as well as being available to print direct 

to hard copy.  A Browse application allows viewing of stored data and graphs, etc. 

 

Also included as part of the software is a maintenance package that allows functions such 

as manual sampling and zero and calibration adjustments to be carried out. 
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4. TECHNICAL SPECIFICATION 
 

 

 

 

Sample System Sample Lines:  10mm o/d, 8mm i/d-reinforced nylon, (HDPE or 

PTFE or PVDF for reactive/absorbent gases), 

ideally installed in a protective pipe. 

 Max. line length:  Up to 1 km 

 Exhausts:  10 mm o/d compression fitting 

 Drains:  6 mm o/d compression fitting 

 Flashback 

arrestors: 

 

 90 m, 1.6 mm thick, 303 stainless steel 

 

 

Cabinet Overall 

dimensions: 

 1000mm (H) x 800mm (W) x 400mm (D) 

 

 Weight:  100 KGs (220 IBS)approximately 

 Temperature 

range: 

 10 to 35 C (50 to 95 F) 

Electrical Power:  mains ac 50/60 Hz 

 Current 

consumption: 

 

 Typically 2Amps AC 

 

 Inputs/Outputs:  Any combination of Relay and Analogue 

Modules, up to a maximum of 4 Modules.  

Relay Modules contain 8 output relays - 4 x 

SPCO 10 A and 4 x DPCO 5 A.  All contacts 

rated at 250 V ac, non-inductive load. 

Analogue modules contain 8 inputs and 2 

outputs, all 4-20 mA, rated at 800  maximum 

load at 24 V dc. 

 

 PC system:  AMD 500 with an internally mounted 3.5” 

1.44Mb disk drive, CD-ROM, 12.5” flat screen 

colour display, and keyboard / mouse-pad. 

 

Microsoft Windows  98 Crowcon GasScan 

suite, PC Anywhere (if modem fitted) 
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5.  MECHANICAL INSTALLATION 
 

Mechanical installation of the system is in three major parts: 

 

1. Optional end of line probes 

2. Sample pipes exhaust and drain lines 

3. System cabinet 

 

5.1  OPTIONAL END OF LINE BOREHOLE PROBES 
 

These provide coarse particulate filtering and a water barrier to prevent dirt and moisture, 

being drawn into the sampling system.  A typical arrangement is shown in the figure below.  

The filter assembly should, if possible be mounted facing downward to avoid ingress of 

rain, spray, etc. There is no limitation on the distance between the filter and the water 

barrier, however it is advisable to mount them as close as possible to minimise any 

accumulation of water in the pipe. 

 

 

 

 

 

 

 

Stock Number Part Description 

M02-190 A Sinter Filter 

M02-191 B Compression Fitting 

M04-326 C 10mm HDPE Tubing 

M04-274 D Water Barrier 

M02-193 E Compression Fitting 
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5.2  SAMPLE PIPES AND EXHAUST AND DRAIN LINES 
 

The sample cabinet is supplied complete with a 10-mm compression fitting for each 

incoming sample line.  All sample pipes should therefore be 10-mm o/d, 8 mm i/d.  Pipe 

material should be suitable for the application, both in terms of the gas being sampled and 

the ambient atmosphere. 

 

Maximum sample pipe length is 1 km.  In any applications where the sample pipes are likely 

to be exposed, they should be installed in protective conduit, preferably metallic.  Wherever 

possible, pipe lengths should be single pieces rather than joined.  Joints are a potential 

leak source and can be particularly troublesome, especially when buried underground. 

 

In applications where pipes, out of necessity, are joined or are back filled after laying, 

pressure testing should be undertaken prior to starting up the system to ensure that the 

pipes are not leaking or blocked. 

 

Pipe runs should be designed with a minimum number of bends to reduce pressure drops.  

Piping manufacturers or suppliers should be contacted for information regarding minimum 

bend radii. 

 

Each sample cabinet includes one or more sample exhaust connections, depending on the 

configuration of the system.  Exhaust lines should be either returned to the process from 

which they were drawn, or vented to atmosphere. If the exhausts are to be vented to 

atmosphere, it is recommended to do so at high level and in a location that will not pose a 

gas exposure risk to plant or personnel.  Exhausts use 10-mm compression fittings. 

 

 

5.3  SYSTEM CABINET 
 

The system enclosure contains the sample conditioning system, pumps and detectors.  The 

actual configuration of the system will depend on the options specified at the time of 

purchase. This information is detailed in the Sampling System specification sheet, and on 

the drawings in Appendix B. 

 When installing the system, allow a minimum clearance of 0.5 metre underneath and either 

side of the enclosure for external connections and in order not to impede fan inlet and 

outlet plates. 
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6.  ELECTRICAL INSTALLATION 
 

 

All relay contacts are volt-free, rated for 5 A for DPCO relays and 10 A for SPCO relays at 

250 V. 

 

The main ac supply should be fed via a fused main spur.  If an optional UPS has been 

supplied to power the PC in the event of an ac failure, suitable cabling will be supplied for 

interconnection to the sampling cabinet. 

 

If a modem is fitted, it should be connected to a high integrity phone line.  It must be a 

direct line, not via a switchboard. 

 

Note: Prior to switch on, check that all electrical connections are correct. 
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7. START-UP 
 

Once all work detailed in Sections 4 and 5 have been carried out and power is applied, the 

system should be fully functioning.  Configuration of the system was accomplished at the 

factory during the production and test phase of the system, and was set up to conform to 

the sampling system specification supplied with the system.   

 

When powered up, the internal PC should automatically start Windows  and open the 

GasScan program installed on the system. 

 

The GasScan program group is shown below. 

 

 
 

 

7.1  GASSCAN 
 

This is the main operating program used for routine operation of the system.  It is 

responsible for controlling, monitoring, displaying and logging functions on the 

system. 

 

 

7.2  SETGAS 
 

This module is used to set the configuration for the GasScan module.  A new 

configuration file may be constructed, or an existing file modified.  The settings 

for GasScan are entered via dialogue boxes and the file then saved.  The name 

of the file that GasScan will use must be set in the [gasscan.ini] section of the 

CROWCON.INI file as store-n=<name>.cfg.  See Appendix C for a full listing of system 

settings in the CROWCON.INI file.  It is important that any changes are made to both the 

site and remote system (if applicable), to ensure both the system and analysis tools use the 

same data. 

 

When supplied from the factory, the system will be loaded with a .cfg file developed from 

the information in the sampling system specification sheet.  The filename, which it has been 

given, will be dependent on the customer, site details, etc., but only one .cfg file should 

exist. 

 

To modify system parameters, double click on the GasScan group icon in Program 

Manager, then double click on the SetGas program icon.  The following screen appears. 
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From the Files menu select Open.  Select the one existing .cfg file and click .  

Selecting Edit... will allow the file to be modified.  When the modifications have been made, 

selecting Save will overwrite the existing file, selecting Save As... will create a new file. 

 

The menus are as follows: 

 

Files menu includes the items as listed below: 

 

New 

Clears current settings from memory, ready to start a new configuration. 

 

Open... 

Allows existing configuration file to be loaded for inspection or modification.  Files are 

saved as type .cfg. 

 

Save 

Saves settings using current file name.  This will overwrite the file with any changes 

made. The changes will not take effect until the system is re-started. 

 

Save As... 

Allows the file to be saved with a different name.  You may keep a large number of 

configurations, named differently, and use them when required by changing the current 

configuration file name in CROWCON.INI See system settings for more information. 

 

Edit  

Allows setting/changing values.  This is where the setting of all parameters that guide the 

operation and display of the data recorder takes place. 

 

The following Set Parameters dialogue box is produced, which sets elements that refer to 

the whole system. 
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Recorder Name is the name used in the display and in reports etc. to refer to the site. 

 

Data Type is the legend used for the scale in graphs and tables (normally „%‟) 

 

No of Channels is the number of physical data channels used by the system.  The 

sampled channels only count ONCE.  i.e. 3 sampled gases plus 5 auxiliary channels equals 

8 channels. 

 

Record Speed is the time between readings in seconds.(minimum 180 seconds) 

 

Scanned display scale is the maximum scale value for the vertical axis in display graphs 

for the sample points. 

 

Live display scale is the maximum scale value for the vertical axis in the live graph. 

 

 

Number of scanned channels is the number of channels that will be interrogated from a 

different sample point each scan.  E.g. if each sample point is used to monitor for methane, 

carbon dioxide and oxygen, the number entered will be three. 

 

 

Number of Sample Points is the number of scanned points to be used from 1 to 32. 

 

 

Relay Sense.  The digital outputs that may be connected to alarms are factory defaulted to 

normally low.  This operates the relays as normally de-energised.  In this case the entry is 

zero.  To change any channel to normally high (relay normally energised) a number must 

be put in this box.  Calculate the required number using the following table. 
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Relay Number Relay Sense Value 

1 1 

2 2 

3 4 

4 8 

5 16 

6 32 

7 64 

8 128 

 

 

Example: If relays 1,4 and 5 are to operate normally energised, the value to enter 

is 1 + 8 + 16 = 25. 

 

A Channels gives access to the analogue channel dialogue box shown on the next page. 

 

D Channels gives access to the digital dialogue box shown later in this chapter. 

 

Sample Points gives access to the Sample Point dialogue box shown later in this chapter. 

 

Finished terminates the edit session.  Select this when all changes have been made.   

 

Note: Remember to save any changes to a configuration file by using the Save 

option in the Files menu otherwise all changes will be lost when you exit the 

program. 

 

 



Programmable Gas Sample System Manual   
 

 

File ref: Manual 12 

Issue 1 

7.2.1   Edit Analogue Channels 
 

This allows the analogue input channels to be configured one at a time.  The required 

channel is selected by means of the  and  buttons.  The selected 

channel is shown at the top. 

 

 
 

 

 

Channel Name is that used in displays and reports. 

 

Scale and Offset convert the physical value read from the converter into the appropriate 

readings.  The general formulae are: 

 

Scale
Maximum value for display scale

Maximum input value -  Minimum input value
 

 
Offset Scale =  - Minimum input value x  

 

The minimum input value and maximum input value are expressed as values that are a 

proportion of 1000 (the actual input range is 1023, but for most purposes 1000 is accurate 

enough). 

 

The maximum value for display scale is typically the full-scale range of the detector, e.g. for 

0-50 PPM, enter 50. 
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Example: The channel needs to be set for 4-20 mA detector scaled 0-50 PPM. 

 

Scale
50

1000
4

20
1000

0 0625.

 

 

Offset = -200 x 0.0625 

  

= -12.5 

 

 

 

Alarm 1 and Alarm 2 groups set relevant elements of the alarms. 

 

Enable activates the alarm 

 

Falling alarm is only checked when the alarm is activated by a falling, rather than rising, 

gas concentration.  Typically this is only normally required for oxygen deficiency alarms. 

  

Report enters the alarm in the reportable alarms table. 

 

Value sets alarm threshold values. 

 

Output allocates the alarm to a specific relay, numbered from 1 to 8 on the relay module. 

 

NOTE: Only two relay modules can be configured direct from SetGas.  Up to two 

more relay modules can be used with each sampling cabinet, configuration 

for which is done using ZoneAlarm. 

 

User cleared.  When checked this will allow the user to reset the alarm while the alarm 

condition is still present.  This is useful for audible outputs. 

 

Output gain.  This scales the analogue output from the channel so that the full-scale 

output from the transmitter corresponds to 20 mA.  The value, with up to two decimal 

places, is determined by dividing 256 by the maximum value of the output. 

 

Example: For a 0-50 PPM transmitter, the Output gain value should be set to 

256  50 = 5.12 

 

I R Bench is only ever checked if a Crowcon built infra red bench is installed as the 

detector on that channel. 

 

Dual detector is only ever checked if two infra red detectors are installed in parallel for 

redundancy purposes. 

 

Finished ends the setting of channels 

 

 



Programmable Gas Sample System Manual   
 

 

File ref: Manual 14 

Issue 1 

7.2.2   Sample Point 
 

The Sample Point dialogue box is follows: 

 

 
 

Name allows the user to enter a four character descriptor that is used to define the sample 

point in reports and system configuration printouts. 

 

Sample time defines the sampling time for that point in seconds. 

 

NOTE: When setting sample times, due consideration should be given to factors 

such as transit time of the sample in the pipe (on systems where no backing 

pump is used) and the response time of the detectors. 

 

 

7.3  RECIPE  
 

As well as performing a sequential reading program around the sampling points, 

a flexible pre-programmed sequence can be followed.  Up to two hundred entries 

of the available sampling points, freely mixed, may be configured into a recipe.  

Up to 99 recipes can be available for operator selection. 

  

 

7.3.1  Producing A Recipe 
 

A recipe is made using a text editor (such as Notepad).  The numbers of the sampling 

points required are entered, separated by commas, line feeds, spaces or other convenient 

symbol.   

 

The contents will look like this: 

 

12,06,13,03,12,16,15,12,14,01, etc. 

 

The file is then saved as a .txt file with an appropriate name. 

 

 

7.3.2  Installing A Recipe 
 

A text file produced as above is installed as an available recipe as follows: 

 

Start the Recipe application.  Use File Open... to select the text file.  The head of the 

window display will indicate the file in use.  Select File Save... and save the recipe with a 

number between 1 and 99.  This is the recipe number that the operator will select. 
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7.3.2.1  Recipe Errors 
 

Recipe will not accept files with more than 200 entries and will truncate files that are longer.  

Entries outside the size of the sampling system will cause sample point 1 to be selected.  

Recipes should be held in the GASSCAN directory.  Failure to locate a recipe will be 

reported by the system when an attempt is made to load it. 

 

 

7.3.2.2  Restart 
 

If Recipe was in operation when the system shutdown, the same recipe will be re-loaded 

when the system re-starts.  The very first reading, however, may not match the first entry. 

 

 

7.4  BROWSE 
 

The Browse module is an off-line viewer of store files.  It allows data gathered at 

another time and/or place to be viewed in the same form as originally recorded. 

 

To access the Browse function double click on the Browse program icon.  Menu functions 

are as follows: 

 

File menu includes the two items as listed below: 

 

Open Config... 

Opens a configuration file (.cfg) that matches the store file to be browsed.  The 

configuration file is that used by the system for its basic operating parameters. The 

store file (.sav) is where the historical data from the system is stored.  Where 

installed, the mimic will also be loaded, if the name is the same as the configuration 

file. 

 

Open Store 

Opens the store file to be browsed. 

 

To Browse any data select Open Config... from the File menu, then select the correct 

.cfg file.  Select Open Store... from the File menu and select the .sav file with the same 

name as the selected .cfg file. 

 

View 

The View menu gives access to three of the four different formats in which the data may be 

displayed, as in the GasScan module.  A scrollbar at the bottom of the screen allows 

moving forward and back through the recorded data.  You may select a point in one display 

(extreme left of line in graphical display) and switch to another display to see the same 

point in another format. 

 

The options within View are as follows: 

 

Table 

This is the default display and gives a „snapshot‟ of the data at a particular reading.  

The scanned channels are displayed in columns at the left with sample points 

numbered down the left-hand side and channel names at the head of the columns. 
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Auxiliary inputs are named and shown in the columns on the right. 

 

The scan rate and sample point that was being scanned are shown beneath the 

auxiliary inputs. 

 

Live 

This displays a line graph of the actual channels that were read.  The auxiliary 

channels are a valid record of the values read.  The sample point values are a „mix‟ of 

all the sample point readings in scan order.  The channel colours are shown at the left 

of the display, timing information at the bottom.  A display of the value and time at the 

point being pointed to by the mouse are shown at the top. 

 

Mimic 

The mimic will be displayed for reference purposes, although no data will be included. 

 

Sample 

This produces a menu option for each sample point on the system.  A graphic display 

appears similar to that given by the Live option, but showing the readings for only the 

selected point. 

 

Display 

The options within Display are as follows. 

 

Update 

This causes Browse to periodically check if the store file it is currently using has been 

added to. 

 

Invert 

Exchanges the graphical display between black or white background.  This makes 

some traces more easily visible, and aids screen capture of graphs with some capture 

programs. 

 

About 

Gives current version information about the module. 

 

 

7.5  CONVERT 
 

This module performs two main functions: 

 

 

Printing of data in tabular format. 

Producing page(s) of data labelled at the column top with bore hole and gas names and in 

the first column with times.  Units of measure, such as LEL or percentage, may be inserted. 

 

Conversion of data to spreadsheet format 

Convert produces a .csv format file suitable for almost all spreadsheets.  Headings are 

included and time converted to the common floating point representation. The normal 

sequence of operation with Convert is as follows. 

 

Select Open Config... from the File menu and select the required file to convert.  Click on 

the  button 
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Select Open Store... from the File menu and select the conversion required.  Click on the 

 button 

 

Convert 

Selecting this option gives access to the conversion settings dialogue box, as below: 

 

 
 

From reading number is the first reading of the block that will be converted. 

 

To reading number is the last reading of the block that will be converted. 

 

Both of the above settings are initially set to the whole of the file selected.  They may be 

set to concentrate on a particular area of interest if so desired. 

 

One line per scan gives one line (in the spreadsheet file or printout) for a complete set of 

bore holes.  This gives all the sample point data in the most compact form.  To produce one 

line per reading uncheck this box.  If „One line per scan‟ is selected, then not all the data 

from auxiliary channels will be produced.  Select how Convert should compress this data. 

 

OK completes the selection. 

 

NOTE: No data is produced until Print or Save As... is selected. 

 

Save spreadsheet file OR Print results. 

 

The options available within Convert are as follows. 

 

File 

 

Open Config... 

Opens a configuration file (.cfg) that matches the store file to be converted. 

 

Open Store... 

Opens the store file (.sav) to be converted. 

 

Save As... 
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Saves the data in spreadsheet format 

 

 

Print 

Prints the data in tabular form. 

 

About 

This displays current version information about the module. 

 

 

8.  ROUTINE MAINTENANCE 

 
 

 

8.1  FILTERS 
 

There are 4 types of filters used within the sample system:- 

 

8.1.1 COALESCING FILTER 
 

This filter performs two functions, firstly it collects any dirt/dust particles that may be in the 

gas sample and secondly it collects any water in the sample line. The water/dust mix 

collects in the bowl of the filter before being forced out of the filter during the purge/drain 

cycle. Minimal maintenance of this filter is required provided there are sufficient drain 

cycles, as it is self-cleaning. However, Crowcon recommends that the filter element is 

removed every 6 months, cleaned in warm water and allowed to dry before being re-

assembled. 

 

8.1.2 POLYCAP FILTER 
 

This filter has a membrane fitted internally that forms a complete barrier to water but allows 

the gas sample to pass through. It is a disposable filter and will only need to be replaced 

when it is completely blocked, usually indicated by a discolouring of the internal membrane. 

A visual inspection on a 3 monthly basis should be sufficient. 

 

8.1.3 ATMOSPHERIC FILTERS 
 

These filters are fitted to the Purge and Calibration inlets and provide particulate filtration to 

protect the pump during purge or calibration. The filter elements should be inspected every 

3 months and replaced every 6 months. 

 

An early warning of filter elements becoming blocked is a visible reduction in the sample 

flow. The sample flow can be checked using the flowmeter mounted inside the sample 

system cabinet and the flow should be in the range of 500cc/min to 1000cc/min.  

 

8.1.4 Cabinet Fan Filters 
 

These square foam filters are fitted to the cabinet vent inlet, and fan outlet. The fan is 

required to regulate the internal temperature of the cabinet, by flowing air through via the 

vent inlet. The filters are fitted to prevent dust from being drawn into the cabinet. It is 
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essential that these filters are regularly replaced. If they become blocked by dust, the 

internal temperature of the cabinet will rise and the system PC may fail. 

 

 

8.2 PUMP MAINTENANCE 
 

The pumps used in this system are designed to require only minimal maintenance. They 

incorporate oil-less operation with permanently lubricated bearings and a long life Buna 

diaphragm with a Teflon liner. The Teflon liner protects the diaphragm from the corrosive 

effects of gases such as Hydrogen Sulphide. This liner should be inspected regularly and 

replaced if necessary. The pump is at risk if the sample system filters are breached, and 

then it is only likely that the pump diaphragm will be punctured. If this is the case the 

sample flow will reduce dramatically and the pump diaphragm will require inspection by 

removing four screws and the cover plate. Pump life is expected to be in excess of 2 years. 

 

 

 

9.  REMOTE CONTROL AND ALARM DIAL OUT 
 

 

 

  

  
 

9.1 OVERVIEW 
 

In the event of an alarm the system can be configured to dial out to a remote computer to 

inform of the event. This is achieved through a program called Remote, which runs on the 

sampling system and constantly monitors for the occurrence of an alarm. If an alarm is 

detected by Remote it will then proceed to dial the first of two numbers that can be set-up. 

This number would normally be a direct line (not through a switchboard) to a remote 

computer, which is running a program called Monitor. Monitor is a small program that can 

be minimised so that the computer can be used for other tasks. When Monitor receives a 

call from Remote it will automatically maximise and become the active window displaying a 

dialog box containing the alarm message. Once the message has been cleared the user 

can then call up the system using PcAnywhere for Windows and interrogate it to assess the 

degree of action necessary. Monitor keeps a record of alarms and the times that they were 

received in a file called alarmlog.txt. During a PcAnywhere remote control session it is also 

possible to transfer files to and from the system, this is especially useful for retrieving the 

systems data logs. The following sections describe the operation and requirements in 

greater detail. 

 

 

9.2 HARDWARE REQUIREMENTS 
 

The hardware required for alarm dial out and remote control is shown below. Crowcon 

would normally supply hardware for the sample system.  

 

 

1. 386 SX or better IBM compatible computer. 

2. 2 MB of RAM minimum. 

3. 7 MB of free hard disk space. 

4. Hayes compatible internal or external modem. 
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5. A direct BT telephone line (does not go through a switchboard). 

6. One free serial communications port (must be either com1 or com2). 

 

9.3 CONFIGURING REMOTE ALARM DIAL OUT 
 

As described in the overview the system can be set-up to dial out to a remote computer to 

inform of alarms. The program responsible for instigating this is called “Remote” and is 

found in the GasScan Windows group with the icon shown above. This program runs only 

on the sample system itself and not on the remote computer. Normally the Remote icon 

would be copied into the Windows start-up group so that it is automatically loaded with 

Windows.  

 

In order for Remote to operate correctly the following parameters need to be present in the 

Crowcon.ini file under the [Remote] heading. Crowcon.ini can be edited using Windows 

Notepad. 

 

 

9.4 CROWCON.INI 
 

[Remote] 

Site = <text> This is the text that will appear on the remote computers screen and is  

   normally the name of the site. A maximum of sixteen characters is allowed. 

 

Modem = n  Where n = the number of the COM port that the modem is to use (either 1 or 

2). 

 

Telephone =  The first number that Remote is required to dial in the event of an alarm. 

 

Tel2=   The second number for Remote to dial if the first number is unobtainable. 

   This is optional. 

 

9.5 OPERATION  
 

Remote will only dial out on alarms that are configured as reportable in the 

system Config file, (see the section on “SetGas” for more information). This 

means that the user can be selective about which alarms are reported remotely. 

In the event of a reportable alarm occurring Remote will dial out using the first 

telephone number and on a successful connection with the remote computer will transmit 

the message set by the Site= parameter in the Crowcon.ini file. The usual response from 

whoever is informed of the alarm would be to dial into the system using PcAnywhere for 

Windows in order to investigate the nature of the alarm and determine the course of action 

necessary. In the event that the first telephone number is unobtainable Remote will try five 

times and then repeat the dial out cycle using the second telephone number. If neither of 

these are successful then Remote will wait for one hour and then try again .In the event 

that a dial out fails to connect successfully to the remote computer then an error will be 

reported and displayed in the Remote window. The error codes and their meanings are 

shown below.  

 

1 Communications line was in use by other software 

2 Could not open communication port 

3 Communication port setting error 

4 Modem did not respond 
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5 No answer to call 

6 No data request received 

7 Data file not found 

8 Next block request not received 

9 End of data transfer not acknowledged 

 

 

9.6 MONITOR CONFIGURATION 
 

The Monitor program runs on the remote computer only, it should not be running on 

the sample system. The only parameter that needs to be set for Monitor is the COM port to 

use. The default COM port is com1 if com2 is required then place the following text in the 

WIN.INI file. 

 

[Monitor] 

Port=2 

 

The WIN.INI file is found in the Windows directory and can be edited using Notepad or any 

text editor or word processor. 

 

9.6.1 Operation 
 

Monitor is a small windows program that runs on the remote computer. When it is active it 

monitors the serial port to which the modem is connected and on receiving an alarm 

message from the sample system it will maximise on the screen and display the alarm 

message. The user has to click the O.K box in order to accept the message. In addition to 

this a line will be written into a text file called alarmlog.txt this will include the name of the 

site and the date and time that the alarm was received as shown below. 

 

Alarm Landfill Site on Fri Feb 28 10:32:47 1997  

Alarm Landfill Site on Fri Feb 28 10:42:12 1997  

Alarm Landfill Site on Fri Feb 28 10:49:10 1997 

 

The text file Alarmlog.txt is found in the GasScan directory of the remote computer and can 

be viewed using Windows notepad or most word processors . 

 

9.6.1.1 Controlling Monitor 
 

Whilst Monitor is active the modem will be unavailable for use by any other software. 

Monitor has a control menu and this gives the option to suspend its operation allowing the 

COM port to be used by other software. 

To suspend Monitor pull down the Control Menu and select OFF, the modem is now free to 

be used by other software such as PcAnywhere. To resume Monitors operation choose On 

from the control menu. When monitor is active ON-AL will be displayed on a red 

background in the monitor window. When Monitor is suspended OFF will be displayed on a 

green background. 
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9.7 SCREEN MESSAGES 
 

A window containing text, up to approximately 10,000 words, can be triggered by any 

sample point alarm.  Simply write a document using Notepad and save it in the GASSCAN 

directory with the name opmessNN.txt where NN is the number of the sample point (use 

leading zeros to make two characters e.g. sample point 3 is opmess03.txt).  If any alarm 

for that sample point is triggered, the document will be displayed on the screen.  This is 

ideal for giving instructions for non-technical staff. 

 

 

 

Note: This is displayed at the end of the read cycle of the event triggering a new 

alarm, which may be up to two minutes after the display first shows that 

alarm.  Care should be taken when using this feature, since the display of a 

large number of messages can consume system resources, slowing or even 

stopping the system.  Messages should be closed after reading. 

 

 

9.8 PCANYWHERE FOR WINDOWS 
 

For information on using PcAnywhere for Windows please refer to the PcAnywhere manual 

supplied with your copy of the software. 

 

9.9  STORES FILES 
 

If the [gasscan] section of the crowcon.ini file contains the message, 

 
STOREDAYS=30  

 

(and Remote is running) then files containing one month‟s data called <name>.mth, where 

.mth is the name of the month, will be created, and a new store file started.  If the previous 

year‟s file is still there, then that file will be renamed to OLDnn.mth where nn is the year to 

which the data refers.  If not removed, the OLDnn.mth will be overwritten the next year 

(two-year-old data).  If Remote is not running then a file <name>.str will hold one month‟s 

data, and the .SAV file will hold all data after that. 

 

10. COMMISSIONING AND SERVICE 
 

Programmable Gas Sampling Systems are supplied factory calibrated and fully 

operationally checked, however Crowcon strongly recommend that gas sampling system 

installations are commissioned. Commissioning includes carrying out a full check of the 

equipment and its wiring as well as calibration and operation checks on all sample lines, 

ensuring that there are no leaks and that the system outputs are correctly configured to 

interface directly with any peripheral equipment. 
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Our Service department will also be pleased to advise on regular service and maintenance 

requirements and we can offer annual maintenance agreements.   

 

 

 

 

 

 

11. TRAINING 
 

Full system operating and calibration training can be arranged by our Service department. 

This can take the form of either on site training or a training seminar at our head office in 

Abingdon, Oxfordshire. Please contact our Service department for further details and a 

quote. 

 

12. WARRANTY 
 

Crowcon products are designed to give years of trouble-free life and our normal guarantee 

is one year. In the unlikely event of one of our systems failing within one year of delivery, 

and it is proved to be defective by reason of faulty workmanship or material we will repair 

and replace any faulty parts, free of charge, subject to our standard conditions below. 

 

1. The guarantee will be rendered invalid if the system or any part of the system is found to 

have been altered, modified, dismantled or misused. 

 

2. We accept no liability for consequential or indirect loss or damage arising and all liability 

in respect of any third party is expressly excluded. 

 

3. The guarantee does not cover the accuracy of calibration after the system has been put 

into use if that calibration has not been undertaken by suitably trained personnel. 

 

4. Our liability in respect of defective equipment shall be limited to the obligations set out in 

the guarantee and any further warranty, condition or statement, express or implied statutory 

or otherwise as to the merchantable quality of our equipment or its fitness for any particular 

purpose is excluded except as prohibited by statute. This guarantee shall not affect a 

consumer‟s statutory rights.  
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 Appendix c:  Spare Parts List 

 

Description  Part Number 

 

Pressure transducer  E01-422 

Press Trans Bracket PSS-2414-A4 M01-554 

Flow Meter  M02-129 

Flow Meter Bracket FSA-1757-A4 M01-478 

Non return Valve (Drain)  M04-641 

3-Port Valve  E01-361 

Solenoid Mounting Bracket FSA-1756-A4 M01-477 

Balston 914 Filter  M02-073 

Balston 914Filter Element  M02-074 

Polycap Filter 36 TF M04-299 

Coalescing Filter  M02-217 

Coalescing Filter Element  M02-223 

Sample Pump 230V E01-478 

Valve Block 8 Station M02-259 

Valve Block Driver Assy  S01-477 

Industrial PC  E01-683 

Keyboard / Mousepad  E01-750 

Crowcon Power Supply 150W E01-546 

Relay Module  S01-476 

Analogue Module  S01-580 

Control Unit Assy  S01-474 

End of line sample filter  M04-274 
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13. APPENDIX D:  LIST OF ITEMS IN THE CROWCON.INI FILE 
 

The crowcon.ini file contains a large number of parameters, which control the way in 

which the programmable gas sample system behaves.  The listing of all the valid variables 

followed by the list of valid values and description is shown in the table below.  These 

parameters should be located under the [GasScan] section of the file. 

 
Fastscan=1 

Enables the fast version of the software suitable for use with a backing pump. 

 
Mono=1 

Enables the monochrome display. 

 
Landfill=1 

Enables the Landfill name to be used for the program. 

 

purgecount=n 

Number of readings between purges. 

 

Purgetime=nn 

Time for purge cycle (minimum 60 seconds). 

 

Lineblow=nn 

Time for backpurge.  This must be long enough to allow all lines to be purged. 

 

Watchdog=n 

n=1 enables the watchdog for the Crowlog Gasmonitor interface. 

n=2 enables the watchdog for the Eventlog interface. 

 

Password=xxxxxxxI 

f this parameter is used GasScan cannot be closed without entering a password.  

Maximum length is 7 characters. 

 
Clamp=1 

Clamps analogue outputs if pressure transducer second alarm activates. 

 

Filesize=n 

Number of readings contained in store files.  Maximum is 32000. 

 

Toggle=n 

Toggles between mimic and table displays at interval set by n seconds. 

 

The following entries should be located under the [Event] section. 

 

LogTo=n 

n=1 Trigger remote alarming 

n=2 Output to a parallel printer 

n=3 Output to a serial port 

n=4 Short form output to serial port 

n=5 Output to text file (EVENTLOG.TXT) 

 

Note: if data is to be sent to a printer via serial port 1, the line “printport=1” must be added 

to the [Event] section. 
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NOTES 

 

 

 

 

 

 

 

 

 

 

 


